DCP-o-matic users’ manual

Carl Hetherington
11 Preferences

11.1 General

11.1.1 Language

11.1.2 Interface complexity

11.1.3 Number of threads DCP-o-matic should use

11.1.4 Number of threads DCP-o-matic encode server should use

11.1.5 Configuration file

11.1.6 Cinema and screen database file

11.1.7 Play sound via

11.1.8 Integrated loudness

11.1.9 Automatically analyse content audio

11.1.10 Updates

11.1.11 Issuer and creator

11.2 Defaults

11.3 Servers

11.4 Keys

11.5 Advanced keys settings

11.6 TMS preferences

11.7 Email

11.8 KDM email

11.9 Accounts

11.10 Notifications

11.11 Cover sheet

11.12 Advanced preferences

12 Frame rates

12.1 DCP frame rate limitations

12.1.1 Guaranteed rates

12.1.2 Other often-supported rates

12.1.3 Adapting content to fit the DCP rate

12.2 Setting up

13 Encoding servers

13.1 Running the servers

13.2 Setting up DCP-o-matic

13.3 Some notes about encode servers

14 Generated files
15 Command-line tools

15.1 dcpomatic2_create

15.2 dcpomatic2_cli

15.3 dcpomatic2_kdm_cli

16 Loose ends

16.1 Resuming encodes

17 Common tasks

17.1 Adding subtitles to an existing DCP

17.1.1 Making a VF DCP

17.1.2 Making a complete DCP with projector-added subtitles

17.1.3 Making a complete DCP with burnt-in subtitles

17.2 Adding soundtracks or subtitles in different languages

18 Playing and verifying DCPs

19 Configuration files
List of Figures

3.1 Creating a new film .............................................. 5
3.2 Dialogue box for creating a new film ......................... 6
3.3 Adding content files ........................................... 6
3.4 Selecting a video content file ................................. 7
3.5 Examining the content ....................................... 7
3.6 Making the DCP ............................................... 7
4.1 Dialogue box for creating a new film ......................... 9
4.2 Selecting a still content file .................................. 10
4.3 The timing tab ................................................. 11
5.1 Creating a new DCP by copying an existing one ............ 13
5.2 Creating a new DCP by referring to an existing one ....... 14
6.1 Video settings tab ............................................ 17
6.2 3D left/right image type ..................................... 17
6.3 3D top/bottom image type .................................. 18
6.4 Filters selector ................................................ 18
6.5 Dialogue box for custom colour conversion ................. 19
6.6 Audio settings tab ........................................... 20
6.7 Audio map example 1 .......................................... 21
6.8 Audio map example 2 .......................................... 21
6.9 Audio map example 3 .......................................... 21
6.10 Calculating audio gain ....................................... 22
6.11 Timed text settings tab ..................................... 23
6.12 Burnt-in subtitles ........................................... 24
6.13 Separate subtitles ........................................... 24
6.14 Timing settings tab .......................................... 25
6.15 Timecode ....................................................... 25
6.16 Timeline ......................................................... 26
6.17 Example image to demonstrate video processing ......... 27
# List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Audio file naming</td>
<td>16</td>
</tr>
<tr>
<td>6.2</td>
<td>Suggested colour conversion settings</td>
<td>19</td>
</tr>
<tr>
<td>11.1</td>
<td>‘Magic’ KDM strings</td>
<td>48</td>
</tr>
<tr>
<td>11.2</td>
<td>‘Magic’ cover sheet strings</td>
<td>50</td>
</tr>
</tbody>
</table>
Chapter 1

Introduction

Hello, and welcome to DCP-o-matic!

1.1 What is DCP-o-matic?

DCP-o-matic is a set of programs to perform the following tasks:

- Creation of Digital Cinema Packages (DCPs) from video, audio, subtitle and closed-caption files.
- Playback and verification of DCPs on a PC/Mac.
- Creation of KDMs for DCPs.

1.2 Licence

DCP-o-matic is free and open-source and is licensed under the GNU GPL.

1.3 Acknowledgements

This manual uses icons from the Tango Desktop Project, with thanks.

1.4 This manual

This manual presents bits of DCP-o-matic’s user interface (such as menu items or buttons) like this.

Notes of an advanced nature are presented like this. Ignore them unless you want to know the gory details.
Chapter 2

Installation

2.1 Windows

To install DCP-o-matic on Windows, download the installer from http://dcpomatic.com/ and double-click it. Click through the installer wizard, and DCP-o-matic will be installed onto your machine.

If you are using a 32-bit version of Windows, you will need the 32-bit installer. For 64-bit Windows, either installer will work, but I suggest you used the 64-bit version as it will allow DCP-o-matic to use more memory. You may find that DCP-o-matic crashes if you run many parallel encoding threads (more than 4) on the 32-bit version.

If you are still using Windows XP, download the specific XP version as it should be more stable on your machine than the ‘normal’ Windows version. Be aware, though, that support for Windows XP will not last forever and you should plan to upgrade if at all possible.

2.2 Mac OS X

DCP-o-matic will run on Mac OS X version 10.6 (Snow Leopard) and higher. DCP-o-matic is split into five separate applications, each of which can be installed by downloading the .dmg, double-clicking to open and then dragging the icon to your Applications folder.

If you are not sure which parts of DCP-o-matic to install, start with the first (main) part.

2.3 Debian, Ubuntu or Mint Linux

You can install DCP-o-matic on:

- Debian 7 (‘wheezy’), 8 (‘jessie’), 9 (‘squeeze’) and unstable (‘sid’)
- Ubuntu 14.04 (‘Trusty Tahr’), 16.04 (‘Xenial Xerus’), 18.04 (‘Bionic Beaver’) and 18.10 (‘Cosmic Cuttlefish’)
- Mint 17, 18 and 19

using .deb packages: download the appropriate package from http://dcpomatic.com/ and double-click it. Debian, Ubuntu or Mint will install the necessary bits and pieces and set DCP-o-matic up for you.

2.4 Fedora, Centos and Mageia Linux

There are .rpm packages for Fedora 27, 28 and 29, Centos 6 and 7 and Mageia 6 on http://dcpomatic.com/
2.5 Arch Linux

Packages for Arch Linux are available from https://aur.archlinux.org/packages/dcpomatic/, thanks to Stefan Karner.

2.6 Other Linux distributions

Installation on other Linux systems (for which no packages are available) is quite hard as it must be compiled from source. If you can’t download packages for your distribution, do let me know by email and I will look into providing packages on the website.

The following dependencies are required:

- FFmpeg
- libsndfile
- libsamplerate
- OpenSSL
- libopenjpeg
- Boost
- libssh
- GTK (on Linux)
- wxWidgets
- libxml++
- xmlsec
- curl
- libzip
- asdeplib with some patches
- libdcp
- libsub
- libxml
- locked_sstream
- rtaudio
- libcxml
- locked_sstream

Once you have installed the development packages for the dependencies, download the source code from http://dcpomatic.com, unpack it and run the following commands from inside the source directory:

```
./waf configure --disable-tests
./waf build
sudo ./waf install
```

With any luck, this will build and install DCP-o-matic on your system. To run it, enter:

```
dcpomatic2
```

in a shell.
2.7 ‘Simple’ and ‘Full’ modes

When you start DCP-o-matic for the first time it will ask you if you want to use ‘simple’ or ‘full’ mode. The difference between these two is that some of DCP-o-matic’s more complex or less-used controls are hidden from view in ‘Simple’ mode. This makes the interface simpler to navigate. You may wish to choose this mode if you do not have much experience with DCP or video processing.

Even if you choose ‘Simple’ mode you can always go back to ‘Full’ mode by changing the Interface complexity setting in the General tab of Preferences.

All the screenshots in this manual are from a copy of DCP-o-matic in ‘Full’ mode.
Chapter 3

Creating a DCP from a video

In this chapter we will see how to create a DCP from a video file using DCP-o-matic. We will gloss over the details and look at the basics.

3.1 Creating a new film

Let’s make a very simple DCP to see how DCP-o-matic works. First, we need some content. Download the low-resolution trailer for the open movie Sintel from their website. Generally one would want to use the highest-resolution material available, but for this test we will use the low-resolution version to save everyone’s bandwidth bills.

Now, start DCP-o-matic and its window will open. First, we will create a new ‘film’. A ‘film’ is how DCP-o-matic refers to some pieces of content, along with some settings, which we will make into a DCP. DCP-o-matic stores its data in a folder on your disk while it creates the DCP. You can create a new film by selecting New from the File menu, as shown in Figure 3.1.

![Figure 3.1: Creating a new film](image)

This will open a dialogue box for the new film, as shown in Figure 3.2.
In this dialogue box you can choose a name for the film. This will be used to name the folder to store its data in, and also as the initial name for the DCP itself. You can also choose whereabouts you want to create the film. In the example from the figure, DCP-o-matic will create a folder called ‘DCP Test’ inside my existing folder DCP into which it will write its working files.

### 3.2 Adding content

The next step is to add the content that you want to use. DCP-o-matic can make DCPs from multiple pieces of content, but in this example we will use a single piece. Click the Add file(s)... button, as shown in Figure 3.3, and a file chooser will open for you to select the content file to use, as shown in Figure 3.4.
Select your content file and click Open. In this case we are using the Sintel trailer that we downloaded earlier. When you do this, DCP-o-matic will take a look at your file. After a short while (when the progress bar at the bottom right of the window has finished), you can look through your content using the slider to the right of the window, as shown in Figure 3.5.

Dragging the slider will move through your video. You can also click the Play button to play the content back.

### 3.3 Making the DCP

In most cases, some adjustments would be made to DCP-o-matic’s settings once the content has been added. For our simple test, however, the default values will suffice, so we can go straight onto making the DCP.

Choose Make DCP from the Jobs menu. DCP-o-matic will encode your DCP. This may take some time (many hours in some cases). While the job is in progress, DCP-o-matic will update you on how it is getting on with the progress bar in the bottom of its window, as shown in Figure 3.6.

![Figure 3.6: Making the DCP](image-url)
When it has finished, the DCP will end up on your disk inside the film’s folder. You can then copy this to a projector via a USB stick, hard-drive or network connection. See Chapter 14 for details about the files that DCP-o-matic creates.

Alternatively, DCP-o-matic can upload your DCP directly to a projector or Theatre Management System (TMS) that is accessible via SCP or FTP across your network. See the TMS preferences in Section 11.6.
Chapter 4

Creating a DCP from a still image

DCP-o-matic can also be used to create DCPs of one or more still images, perhaps for an advertisement or an on-screen announcement. This chapter shows you how to do it.

As with DCPs made from video files, the first step is to create a new ‘Film’; select New from the File menu and the new film dialogue will open as shown in Figure 4.1.

Figure 4.1: Dialogue box for creating a new film

Enter a name and click OK. Now we need to add the content. As before, click Add file(s).... For our example, we will add a single image file, as shown in Figure 4.2.
Figure 4.2: Selecting a still content file

Most of the default settings will be fine for a simple test. The one thing that you might wish to change is the length of the still. Select the Timing tab and you will see a Full length setting, as shown in Figure 4.3.
This length is a ‘timecode’: it consists of four numbers. The first is hours, the second minutes, the third seconds, and the fourth frames. Enter the duration that you want and then click Set.

Finally, as with video, you can choose Make DCP from the Jobs menu to create your DCP. This will be much quicker than creating a DCP from a video file, as DCP-o-matic only needs to encode a single frame which it can then repeat.
Chapter 5

Manipulating existing DCPs

DCP-o-matic is often used to take content in formats such as MP4 and make it into a DCP. It can also be used to take existing DCPs and modify them in various ways.

5.1 Importing a DCP into DCP-o-matic

The first step in manipulating an existing DCP is to import it. Click Add DCP... and select your DCP’s folder. It will be added to the DCP-o-matic project. If the DCP is unencrypted you can preview it in the normal way, though playback will be slow as decoding of DCPs is almost as computationally intensive as encoding them.

If your DCP is a Version File (VF) (i.e. it refers to another DCP’s assets) you should import it as follows:

- Use Add DCP... to import the VF DCP. The VF DCP will be added to the content list and marked “NEEDS OV”.
- Right-click on the VF DCP in the content list and choose Add OV... from the menu.
- Choose the folder that contains the OV DCP. The VF will now be playable as normal.

5.2 Decrypting encrypted DCPs

DCPs can be encrypted (see Chapter 10 for details). If you import an encrypted DCP you will need a key, in the form of a Key Delivery Message (KDM), to decrypt it.

KDMs must be prepared by the organisation which created the DCP. They contain the keys to decrypt the DCP wrapped up in such a way that only the intended recipient can read them. You will need to provide the organisation with a certificate which identifies your copy of DCP-o-matic and allows them to create a KDM for you.

To get DCP-o-matic’s decryption certificate, open the Preferences dialogue (see Chapter 11) and go to the Keys tab. Click the Export DCP decryption certificate... button at the bottom of this tab and save the certificate. Send this certificate to the DCP creators and they can create a KDM to allow DCP-o-matic to decrypt their DCP.

Once you have your KDM, right-click the DCP’s name in DCP-o-matic and choose Add KDM.... Specify your KDM and the DCP will be decrypted and become available for preview.

5.3 Making a DCP from a DCP

In many ways, using DCPs as content in DCP-o-matic is the same as using any other content. There are a few things to note, though.
5.3.1 Re-use of existing data

Where possible DCP-o-matic will re-use existing JPEG2000-compressed data from DCP content without modification. This has the advantage that creation of the new DCP will be quick, as the time-consuming JPEG2000 encoding is not necessary.

DCP-o-matic can do this if you avoid changes to the following content settings:

- Crop
- Scaling
- Subtitle burn-in
- Fades
- Colour conversion

DCP-o-matic will be forced to decode and re-encode your JPEG2000 data if you change any of these settings on a piece of DCP content.

5.3.2 Making overlay files

With its default settings, DCP-o-matic will take any data from DCP content and copy it into the DCP that it creates. See Figure 5.1.

![Diagram showing re-use of existing data](Picture.png)

Figure 5.1: Creating a new DCP by copying an existing one

This can be inefficient in some cases. Consider, for example, a film which has ten different translations for which the subtitles are different but video and audio are the same. If the video and audio content takes up, say, 100Gb this means that the set of DCPs for every translation would be about 1Tb with a lot of duplicated data.

The DCP format has a solution to this problem. One DCP can refer to the ‘assets’ (picture, sound or subtitle) of another DCP. For our translation example this means that we could have a ‘base’ DCP (often called the OV or Original Version) containing video, audio and one set of subtitles and then any number of overlay DCPs (often called VF or Version Files) which refer to the base version and replace the original subtitles with their own. Figure 5.2 shows this principle for one of our translations. The DCP that we make refers to the original content DCP’s video and audio rather than containing a copy.
To play back the subtitled DCP the projectionist ingests both the base (OV) DCP and the overlay (VF) DCP, then plays the VF one.

To make a DCP like this:

- Import your ‘Content DCP’ to a DCP-o-matic project.
- Add whatever replacement you want in your new DCP (replacement subtitles or audio files, for example).
- Select the DCP in the content list
- Tick the Use’s this DCP’s ... as OV and make VF checkbox in the tabs for the parts of the DCP that you want to refer to in your new DCP. For example, to refer to the Content DCP’s video and audio you would select the Video tab, click Use this DCP’s video as OV and make VF then select the Audio tab and click Use this DCP’s audio as OV and make VF.
- Do Make DCP as usual and your VF DCP will be created.
Chapter 6

Content settings

The previous chapters showed DCP generation using the default settings. DCP-o-matic offers a range of features to adjust the content that goes into your DCP, and this chapter describes those features in detail.

6.1 Adding and removing content

At the top of the Content tab is a list of the content that will go into our DCP. There can be as many pieces of content as you like, and they can be of the following types:

- Movie — a file containing some video, probably some audio and possibly some embedded subtitles; for example, a MOV, MP4 or VOB.
- Sound — a file containing one or more channels of audio; for example, a WAV or AIFF file.
- Still image — a file containing a single still image; for example, a JPEG, PNG or TIFF file.
- Moving image — a directory containing many still images which should be treated as the frames of a video.
- Subtitle — a file containing subtitle which will be superimposed on the image of the DCP. These can be .srt, .ssa, .ass or .xml files.
- DCP — an existing DCP.

To add one or more movie, sound, still-image or subtitle files, select Add file(s)... and choose them from the selector. DCP-o-matic will automatically map a set of audio files to the correct channels if you include appropriate ‘tags’ in your filenames, as shown in Table 6.1.

To add a directory (folder) of images, choose Add folder... and choose the directory from the selector. DCP-o-matic will open a small dialogue box where you can enter the frame rate that the image sequence should be run at.

To add a DCP, choose Add DCP... and choose the DCP’s directory from the selector.

You can remove a piece of content by clicking on its name and then clicking the Remove button.

6.2 Adding existing DCPs

Adding existing DCPs to a DCP-o-matic film is a little different to adding other types of content. Most content has to be converted to JPEG2000, the compression scheme used by DCPs, which is a very time-consuming process. Existing DCPs are already in JPEG2000 format so do not require conversion. This means that, provided no settings such as crop are used on the DCP content, picture and sound data will be passed from existing to new DCP unaltered.
<table>
<thead>
<tr>
<th>Tag</th>
<th>Examples</th>
<th>Channel</th>
</tr>
</thead>
</table>
| L surrounded by . _ or - | film-L.wav  
my_movie_L_final.wav | Left     |
| R surrounded by . _ or - | film-R.wav  
my_movie_R_final.wav | Right    |
| C surrounded by . _ or - | film-C.wav  
my_movie_C_final.wav | Centre   |
| Lfe surrounded by . _ or - | film-Lfe.wav  
my_movie_Lfe_final.wav | LFE (sub) |
| Ls surrounded by . _ or - | film-Ls.wav  
my_movie_Ls_final.wav | Left surround |
| Rs surrounded by . _ or - | film-Rs.wav  
my_movie_Rs_final.wav | Right surround |

Table 6.1: Audio file naming

Encrypted DCPs that are added as content will require a KDM targeted at DCP-o-matic so that DCP-o-matic can decrypt them. You should ask the creator of the imported DCP to provide a KDM for DCP-o-matic’s decryption certificate, which can be obtained by clicking Export DCP decryption certificate... from the Keys tab of the Preferences dialog (see Section 11.4).

6.3 Content Properties

Below the content list are the controls to set content properties. To adjust the properties for a piece of content, click its name in the content list. The content property controls will then become active for that piece of content.

If you want to change the properties for multiple pieces of content at the same time, select the content in the list by clicking the first piece then clicking the other pieces with shift key held down. Note that not all settings can be changed in this way.

The content properties are split up into four sections: Video, Audio, Timed text and Timing. Not all of these sections will be active for all content types. The controls in each section are described below.

6.4 Video

The Video tab controls properties of the image, as shown in Figure 6.1.
6.4.1 Use this DCP’s video as OV and make VF

This option is only applicable if the selected content is an existing DCP. It allows you make a VF DCP, using the video content from the existing DCP by referencing it (rather than copying). See Section 5.3.2.

6.4.2 Image type

The next option on this tab is the ‘type’ of the video. This specifies how DCP-o-matic should interpret the video’s image. 2D is the default; this just takes the video image as a standard 2D frame. The 3D left/right option tells DCP-o-matic to interpret the frame as a left-right pair, as shown in Figure 6.2.

![3D left/right image type](image)

Alternatively the 3D top/bottom option tells DCP-o-matic to see the frame as a top-bottom pair, as shown in Figure 6.3.

![3D top/bottom image type](image)
Another option is 3D alternate which takes the first frame of the content as for the left eye, the second for the right eye, the third for the left, and so on. Finally, you can specify 3D left only or 3D right only if this content contains only the the left or right eye images. This is useful when you have the left and right eye image sets in different files; you can specify one content as 3D left only and another as 3D right only and DCP-o-matic will pick up the appropriate frames from each.

6.4.3 Filtering

The ‘filters’ settings allow you to apply various video filters to the image. These may be useful to try to improve poor-quality sources like DVDs. You can set up the filters by clicking the Edit button next to the filters entry in the setup area of the DCP-o-matic window; this opens the filters selector as shown in Figure 6.4.

After changing the filters setup, you will need to regenerate the DCP to see the effect on the cinema screen. The
preview in DCP-o-matic will update itself whenever filters are changed, though of course this image may be smaller and of lower resolution than a projected image!

### 6.4.4 Colour conversion

The Colour conversion setting specifies what colour transforms and gamma correction DCP-o-matic will use when converting the selected content into the XYZ colourspace for the DCP.

The easiest way to select the required conversion is to choose one of DCP-o-matic’s presets. DCP-o-matic knows how to convert from four common colourspaces: sRGB, Rec. 601, Rec. 709 and P3. If you do not know which preset you should use, refer to the suggestions in Table 6.2.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sRGB</td>
<td>Still images in RGB, e.g. photographs.</td>
</tr>
<tr>
<td>Rec. 601</td>
<td>Standard-definition content (fewer than about 1000 pixels across) including DVD rips.</td>
</tr>
<tr>
<td>Rec. 709</td>
<td>High-definition content including Blu-Ray rips.</td>
</tr>
<tr>
<td>P3</td>
<td>Content explicitly graded to P3.</td>
</tr>
</tbody>
</table>

Table 6.2: Suggested colour conversion settings

For other required colour conversions, and if you know what you are doing, you can choose Custom which will open the full colour conversion editing dialogue box:

![Figure 6.5: Dialogue box for custom colour conversion](image)

Alternatively, choose None if your source files are already in the XYZ colour space and require no conversion.
DCP-o-matic’s colour conversion processes are discussed in much more detail in a separate document colour.pdf.

6.4.5 Other settings

The **crop** settings can be used to crop your content, which is often used to remove black borders from the edges of the image. The specified number of pixels will be trimmed from each edge, and the content image in the right of the window will be updated to show the effect of the crop.

The **fade in** and **fade out** settings can be used to apply linear fades into and out of a piece of content. Specify the time for each, clicking **Set** after making any changes.

The **Scale to** option governs the shape that DCP-o-matic will scale the content’s image into. Select the aspect ratio that your content should be presented in.

6.4.6 Video description

At the bottom of the video tab is a short description of what will happen to your video with the current settings. In the example of Figure 6.1, DCP-o-matic is telling you that the video file is 2048x872 pixels and it has square pixels (a pixel aspect ratio of 1.00) hence its display aspect ratio is 2.35:1. Since the controls specify ‘2.35’ for the ratio, DCP-o-matic does not scale the image but pads it to the DCP’s container ratio of 1.85:1. For a 2K DCP this is 1998x1080 pixels.

This description also gives the frame rate of the content and what will happen to it when it is played at the DCP’s frame rate. See Chapter 12 for details of DCP-o-matic’s frame-rate conversion.

6.5 Audio

The **Audio** tab controls properties of the sound, as shown in Figure 6.6.

![Audio settings tab](image)

Figure 6.6: Audio settings tab
6.5.1 The audio map

The section at the bottom of the audio tab is the ‘audio map’. This governs how sound from the content will be arranged in the DCP.

Down the left-hand side of the map is the list of audio channels in the currently-selected piece of content. These are labelled with two numbers; the first is the stream index within the content and the second is the channel number within that stream. Some content will have different streams for different languages or audio mixes. Along the top is each channel in the DCP. A green box means that the corresponding content channel will be copied into the corresponding DCP channel.

When content channels are copied into DCP channels they can be done with variable gain. If, for example, you want to copy a channel as-is, you can set a gain of 0dB. Alternatively, if you want to mix two channels into one, you may want to use a gain of -6dB on each one to prevent clipping when the two channels are added.

The green boxes of the audio mapping view tell you (very roughly) how much gain is applied to each channel. A full-height box means 0dB (i.e. unity) gain. Any less height indicates lower gain.

To map one channel to another with 0dB gain, click in the empty box and it will turn green to reflect the mapping. A second click will turn the mapping back off. To set some other gain, right-click on the box to open the gain menu. This allows you to set Off (no mapping or negative infinity gain), Full (0dB gain), -6dB gain or Edit which allows you to set the required gain precisely.

Consider, for example, the case in Figure 6.7.

![Figure 6.7: Audio map example 1](image)

Here, we have two channels in the source which are mapped to left and right, respectively, in the DCP. The full green boxes show that the mapping is at unity gain (0dB) in each case. Imagine that we modify the settings to those shown in Figure 6.8

![Figure 6.8: Audio map example 2](image)

We now have the content’s streams mapped to left and right and also mixed together and placed in the DCP’s centre channel. The smaller green boxes on the centre mappings show that those channels are added with some non-unity gain; you can see by hovering the mouse pointer over those boxes that the gain for content channels 1 and 2 is -6dB when being sent to the centre channel and 0dB when being sent to left and right.

![Figure 6.9: Audio map example 3](image)

As a final example, the map in Figure 6.9 shows the mapping of a 5.1 source into a 5.1 DCP.
6.5.2 Other controls

The Use this DCP’s audio as OV and make VF checkbox is only applicable if the selected content is an existing DCP. It allows you to make a VF DCP, using the audio content from the existing DCP by referencing it (rather than copying). See Section 5.3.2.

Show graphs of audio levels will analyse the audio of the selected content and plot it on a graph. See Section 7.2 for more details.

‘Audio Gain’ is used to alter the volume of the soundtrack. The specified gain (in dB) will be applied to each sound channel of your content before it is written to the DCP.

If you use a sound processor that DCP-o-matic knows about, it can help you calculate changes in gain that you should apply. Say, for example, that you make a test DCP and find that you have to run it at volume 5 instead of volume 7 to get a good sound level in the screen. If this is the case, click the Calculate... button next to the audio gain entry, and the dialogue box in Figure 6.10 will open.

![Figure 6.10: Calculating audio gain](image)

For our example, put 5 in the first box and 7 in the second and click OK. DCP-o-matic will calculate the audio gain that it should apply to make this happen. Then you can re-make the DCP (this will be reasonably fast, as the video data will already have been done) and it should play back at the correct volume with 7 on your sound-rack fader.

Current versions of DCP-o-matic only know about the Dolby CP650 and CP750. If you use a different sound processor, and know the gain curve of its volume control, get in touch.

Audio Delay is used to adjust the synchronisation between audio and video. A positive delay will move the audio later with respect to the video, and a negative delay will move it earlier.

6.6 Timed text (subtitles and closed captions)

The timed text tab contains settings related to subtitles and closed captions in your content, as shown in Figure 6.11.
Depending on where timed text comes from it can sometimes be used as either an open subtitle (to be overlaid onto the cinema screen and seen by everybody) or as a closed caption (to be displayed to individual viewers using a special system such as the Doremi CaptiView™)

DCP-o-matic can either:

- Extract timed text that is embedded in video files, or
- Use timed text from SubRip (.srt), SubStation Alpha (.ssa or .ass) or DCP XML files. You may find the great free program Subtitle Edit useful for creating such files.

Embedded timed text is usually represented using a set of bitmaps, especially on files that have come from DVD or BluRay. Such text can be used as a subtitle, but not a closed caption (since the closed captioning system requires the text to be delivered as character codes rather than an image).

In contrast, SubRip, SubStation Alpha or DCP text can be used as either a subtitle or a closed caption.

With subtitles you have the further choice of whether to burn the subtitles into the image or include them as a separate subtitle ‘asset’ within your DCP (in which case the projector overlays them onto the image on playback). The difference between burn-in and overlay is illustrated by Figure 6.12 and Figure 6.13.
The advantage of separate subtitles is that the same video content can be used for DCPs in many different languages. This means that only a small text file needs to be changed for each target language, rather than a large video file. It also means that the time-consuming video encoding need only be done once for the project rather than once for every language.

Select the **Use as** check-box to enable the timed text in the selected content, then choose what you want to use the text for: open subtitles or closed captions.

Select the **Burn subtitles into image** check-box to burn subtitles into the image; if this is not ticked the subtitles will be included separately in the DCP to be rendered by the projector.

The **X Offset** and **Y Offset** controls move subtitles around within the image. These controls have no effect for closed captions. The offsets are expressed as a percentage of the video frame size; 100% X offset is the entire width of the image.
frame, and 100% Y offset is the entire height. Hence, to move the subtitles down by half the frame height you would use a Y offset of 50%.

The X Scale and Y Scale controls scale subtitles. These controls have no effect for closed captions. Scale values of 1 make the subtitles the same size (relative to the size of the image) as they are on the original. Values lower than 1 make them smaller, and values higher make them larger. You can stretch the subtitles in either direction by specifying different values for X and Y scale. Subtitles from DVD and Blu Ray sources are frequently larger (relative to the video frame) than those typically used for DCP, so it is often useful to scale such subtitles down using these controls.

The Line spacing control adjusts the line spacing of the subtitles. This only works for subtitles that did not come from bitmaps.

The Stream control changes the subtitle stream that is used when the content has more than one.

If you are using non-image (text) subtitles or closed captions you can see the subtitle text and timings by clicking the View... button, or specify the fonts that should be used by clicking Fonts....

With any subtitles you can click Appearance... to change how the subtitles look. Some of the controls in the Appearance only apply to burnt-in subtitles, as only limited control is available for subtitles rendered by the projection system.

### 6.7 Timing

The timing tab contains settings related to the timing of your content, as shown in Figure 6.14.

![Figure 6.14: Timing settings tab](image)

Most of the timing tab’s entries are time-codes. These are expressed as four numbers, as shown in Figure 6.15.

![Figure 6.15: Timecode](image)
Position is the time at which this piece of content should start within the DCP. In most cases, this will be 0:0:0:0 to make the content start at the beginning of the DCP.

Full length is the length of the piece of content. This can only be set for still-image content: for video or sound content, it is fixed by the nature of the content file. If still-image content is being used you can set the length for which it should be displayed using this control.

Trim from start specifies the amount that should be trimmed from the start of the content. You can set this amount to trim up to the current preview position by clicking Trim up to current position.

Trim from end specifies the amount that should be trimmed from the end of the content. You can set this amount to trim after the current preview position by clicking Trim after to current position.

Play length indicates how long this piece of content will be once the trims have been applied. This will be equal to the full length minus trim-from-start and minus trim-from-end.

Video frame rate specifies the frame rate for still-image content. It can also be used to override the detected frame rate of other content if DCP-o-matic has got it wrong.

Each timecode control has a Set which you should click when you have entered a new value for a timecode. The Set button will make DCP-o-matic take account of any changes to the corresponding timecode.

6.8 Timeline

The timeline window gives an overview of all the pieces of content in your film, and how they are arranged. You can open the timeline by clicking the Timeline... button next to the content list. This will open a window like the one in Figure 6.16.

![Timeline](image)

**Figure 6.16: Timeline**

The horizontal axis represents time, and you can see the time codes (in hours:minutes:seconds) along the bottom of the window. Pieces of content are represented with rectangles in the main part of the window. Content containing different types of data (e.g. a MP4 file with video, audio and subtitles) have a rectangle for each type.

Within the timeline you can select content by clicking, and drag it to change its position. Right-clicking a piece of content will open the content menu.

The toolbar at the top of the window offers the following tools:
• Select — to select and move content.
• Zoom in — to drag out an area that you want to see more closely.
• Zoom out — to zoom out so that the window shows the whole film.
• Snap — when enabled, content will snap to other content when you drag it close.
• Sequence — when enabled, content will be kept in sequence, without gaps, even if some content is removed.

6.9 Video processing pipeline

This section gives a little more detail about how DCP-o-matic process video as it takes it from a source and puts it into a DCP.

Consider, as a somewhat over-the-top example, that we have a 720 x 576 image which is letterboxed with 36 black pixels each at the top and bottom, and the video content within the letterbox should be presented in the DCP at ratio of 2.39:1 within a 1.85:1 frame (such as might happen with a trailer). The source image is shown in Figure 6.17.

![My scope image](image)

Figure 6.17: Example image to demonstrate video processing

DCP-o-matic runs through the following steps when preparing an image for a DCP:

• Crop
• Scale
• Place in container

First, some amount of the image can be cropped. This is almost always used to remove black borders (letterboxing and/or pillarboxing) around images.

In our example image, we would use 36 pixels of crop from the top and bottom. This would give the new image shown in Figure 6.18.
The next step is to scale the image. Since this content should be presented in a 2.39:1 (scope) aspect ratio inside a 1.85:1 (flat) DCP we would select Scope from the Scale to option in the Video tab and Flat from the Container option in the DCP tab.

The Scale to option should always be set to the aspect ratio at which the content should be seen. The Container option should be set to the preset that you want to use on the projector. Of course, these two settings will often be the same.

Given the scaling and container information, DCP-o-matic will look at the DCP’s container size, and then scale the source image up until one or both of its dimensions (width, height or both) fits the size of the container, all the while preserving the desired aspect ratio.

In our example here, the DCP’s container is specified as 1.85:1 (so that the DCP will play back correctly using the projector’s ‘Flat’ preset). At 2K, 1.85:1 is 1998 pixels by 1080. Scaling the source up whilst preserving its 1.85:1 aspect ratio will result in the image hitting the sides of the container first, at a size of 1998 x 836. This gives us a new version of the image as shown in Figure 6.19.

The final step is to place the image into the DCP. In this case, since we have a 2.39:1 image that should be presented as a 1.85:1 DCP, we have set the container in the DCP tab to be Scope. Since the content has been scaled to 1998 x 836, and a Flat container is 1998 x 1080, there will be some black bars at the top and bottom of the image. DCP-o-matic shares out this black equally, as shown in Figure 6.19.
6.10 Copy and paste settings

Once you have set up a piece of content it is possible to copy the settings you have applied to another piece of content. To do this, select the content to copy from and choose Copy from the Edit menu. Then select the content to copy to and choose Paste. A dialogue box will open to allow you to choose which settings you want to copy. Clicking OK will apply the copied settings.
Chapter 7

DCP settings

This chapter describes the settings that apply to the whole DCP. The controls for these settings are in the DCP tab of the main window, as shown in Figure 7.1.

The first thing here is the name. This is generally set to the title of the film that is being encoded. If Use ISDCF name is not ticked, the name that you specify will be used as-is for the name of the DCP. If Use ISDCF name is ticked, the name that you enter will be used as part of a ISDCF-compliant name.
Underneath the name field is a preview of the name that the DCP will get. To use a ISDCF-compliant name, tick the Use ISDCF name check-box. The ISDCF name will be composed using details of your content’s soundtrack, the current date and other things that can be specified in the ISDCF name details dialogue box, which you can open by clicking on the Details button.

If you want to take the ISDCF-compliant name that DCP-o-matic generates and modify it, click Copy as name and the ISDCF name will be copied into the Name box. You can then edit it as you wish. The DCP name should not matter (in that it should not affect how the DCP ingests or plays) but projectionists will appreciate it if you use the standard naming scheme as it makes it easier to identify details of the content.

The Content Type option can be ‘feature’, ‘trailer’ or whatever; select the required type from the drop-down list. On some projection systems this will affect where your content appears in the projector’s server user interface, so take care to select an appropriate type.

The Signed check-box sets whether or not the DCP is signed. This is rarely important; if in doubt, tick it.

The Encrypted check-box will set whether the DCP should be encrypted or not. If this is ticked, the DCP will require a KDM to play back. Encryption is discussed in Chapter 10.

If you use encryption DCP-o-matic will generate a random encryption key for you. To specify your own key, click the Edit.. button next to the key.

The Reels and Reel length controls specify how the DCP will be split up into ‘reels’. See Section 7.1.

The Standard option specifies which of the two DCP standards DCP-o-matic should use. If in doubt, use SMPTE (the more modern of the two).

Ticking the Upload DCP to TMS after it is made will ask DCP-o-matic to copy the finished DCP to your configured TMS (see Section 11.6).

At the bottom of the DCP tab are a further two tabs, one each to contain the settings for the DCP’s video and audio parts.

The Container option sets the ratio of the image in the DCP. If this ratio is different to the ratio used for any content, DCP-o-matic will pad the content with black. In simple cases this should be set to the same ratio as that for the the primary piece of video content. Alternatively, you might want to pillarbox a small format into a Flat container: in this case, select the small format for the content’s ratio and ‘Flat’ for the DCP.

The Frame Rate control sets the frame rate of your DCP. This can be a little tricky to get right. Ideally, you want it to be the same as the video content that you are using. If it is not the same, DCP-o-matic must resort to some tricks to alter your content to fit the specified frame rate. Frame rates are discussed in more detail in Chapter 12.

The Use best button sets the DCP video frame rate to what DCP-o-matic thinks is the best given the content that you have added.

The 3D button will set your DCP to 3D mode if it is checked. A 3D DCP will then be created, and any 2D content will be made 3D compatible by repeating the same frame for both left and right eyes. A 3D DCP can be played back on many 3D systems (e.g. Dolby 3D, Real-D etc.) but not on a 2D system.

The Resolution tab allows you to choose the resolution for your DCP. Use 2K unless you have content that is of high enough resolution to be worth presenting in 4K.

The JPEG2000 bandwidth; setting changes how big the final image files used within the DCP will be. Larger numbers will give better quality, but correspondingly larger DCPs. The bandwidth can be between 50 and 250 megabits per second (Mbit/s). Most commercial DCPs use bit rates between 75 and 125 Mbit/s.

Re-encode JPEG2000 data from input governs whether or not JPEG2000-encoded data from a piece of content (usually a DCP) will be re-used in the output data as-is or whether it will be decoded and re-encoded by DCP-o-matic. If the option is enabled DCP-o-matic will decompress any JPEG2000 data it finds and re-encode it. This is useful if you want to reduce the bitrate of a DCP. Usually you will achieve better quality and quicker results by leaving this option switched off.

The Audio Channels control sets the number of audio channels that the DCP will have. If the DCP has any channels for which there is no content audio they will be replaced by silence. You can only set an even number of channels here, since that is required by the DCI standard. If you want an odd number of channels, set the DCP channel count to one greater than you need and the unused channel will be filled with silence.
The Processor control allows you to select a process to apply to the audio before it goes into the DCP. Three processes are currently provided:

- **Mid-side decode** — this will take a L/R stereo input and extract the common part (corresponding to the ‘Mid’ in a mid-side signal) into the DCP’s centre channel. The remaining L/R parts will be kept in the L/R channels of the DCP. This may be useful to make near-field L/R mixes more compatible with cinema audio systems.

- **Stereo to 5.1 up-mixer A** — this will take a stereo input and up-mix it to ‘fake’ 5.1. The input L/R are treated as follows:
  - DCP L is input L bandpass-filtered between 1.9kHz and 4.8kHz.
  - DCP R is input R bandpass-filtered between 1.9kHz and 4.8kHz.
  - DCP C is input L mixed with input R, taken down by 3dB and then bandpass-filtered between 150Hz and 1.9kHz.
  - DCP Lfe is input L mixed with input R, taken down by 3dB and then bandpass-filtered between 20Hz and 150Hz.
  - DCP Ls is input L bandpass-filtered between 4.8kHz and 20kHz.
  - DCP Rs is input R bandpass-filtered between 4.8kHz and 20kHz.

  This upmixing algorithm is due to Gérald Maruccia.

- **Stereo to 5.1 up-mixer B** — this uses a different approach:
  - DCP L is input L.
  - DCP R is input R.
  - DCP C is input L + input R taken down by 3dB.
  - DCP Lfe is DCP C bandpass filtered between 20Hz and 150Hz.
  - DCP Ls and Rs are input L - input R with a 20ms delay.

The up-mixers are not particularly advanced and should be used with care. You are strongly advised to check how the DCPs sound in a cinema if you have used one of DCP-o-matic’s upmixers.

### 7.1 Reels

A ‘reel’ in a DCP is a subsection of the DCP, in the same way as a 35mm reel is a section of a film. A DCP can be split up into any number of reels and the joins (the equivalent to 35mm splices or changeovers) between the reels are seamless.

There is no reason why you can’t just use a single reel for the whole of your DCP, as there is no limit to their length. Many people choose to do this.

There are, however, some possible advantages of splitting things up into reels:

- The picture, sound and subtitle data of the DCP will be split up into more smaller files on disk, rather than fewer larger files. This can be useful if the DCP is to be transferred on storage that have file size limits. The FAT32 filesystem, for example, can only hold files smaller than 4Gb. A 6Gb DCP with a single reel could not be transferred using a FAT32-formatted disk. If that DCP were split up into two 3Gb reels it could be transferred.

- It is easier to re-use DCP components if they are in reels. Consider, for example, a film company who wants to put a 5 second ident onto the beginning of DCPs that they distribute. If they receive a feature film DCP they can modify it to add their ident as a separate reel. This is easier than attaching the picture data to the feature’s existing data.
DCP-o-matic offers three options for setting up the reels in your DCP: single reel, split by video content or custom.

Single reel, as its name suggests, keeps the whole DCP as one reel. This is a perfectly good option if you have no particular reason to need reels.

Split by video content puts each piece of source video content in its own reel, as shown in Figure 7.2.

![Figure 7.2: Making reels using split by video content](image)

Here we have three video files (ident.mp4, feature.ts and cred.mov). With split by video content DCP-o-matic makes a new reel to hold each video file.

Custom splits reels by the size of the files that will make up their video content. With Custom you must specify a reel length in Gb. Then no file in the DCP will be larger than this reel length.

### 7.2 Show audio

The Show Audio button will instruct DCP-o-matic to examine the audio in your content and plot a graph of its level over time. This can be useful for getting a rough idea of how loud the sound will be in the cinema auditorium. A typical plot is shown in Figure 7.3

![Figure 7.3: Audio plot](image)
The plot gives the audio level (vertical axis, in dB) with time (horizontal axis). 0dB represents full scale, so if there is anything near this you are in danger of clipping the projector’s audio outputs.

There are two plot types: the peak level and the RMS, which can be shown or hidden using the check-boxes on the right hand side of the window.

The channel check-boxes will show or hide the plot(s) for the corresponding channels in the DCP.

The smoothing slider applies a variable degree of temporal smoothing to the plots, which can make them easier to read in some cases.

Obviously the audio plot is no substitute for listening in an auditorium, but it can be useful to get levels in the right rough area.
Chapter 8

Templates

If you frequently make DCPs with similar settings you may find it useful to use templates.

Say, for example, you often make 4K feature DCPs from video files in 'scope at 25fps. You can speed up this process by following these steps:

• Create a film with any content and set it up how you like; in our example, set the content to scale to DCP, the DCP resolution to 4K, and so on.
• Choose Save as template... from the File menu.
• Enter a name for your template.

Then in the future you can create a new film, tick the Template box and choose your previously-saved template. The basic film’s settings will come from your template, and when you add some content it will take on the settings of the first similarly-typed piece of content in your template.

For example, if the template has a piece of video content and some subtitles, any video that you add to the new film will take on the settings of the video in the template. Similarly, any subtitles that you add will take on the settings of the subtitles from the template.

The following settings from the DCP tab are saved in templates:

• “Use ISDCF name” checkbox
• Content type (FTR, TLR etc.)
• Container
• Resolution
• JPEG200 bandwidth
• Video frame rate
• Signed and encrypted checkboxes
• Audio channels
• Standard (Interop / SMPTE)
• Audio processor
• Reel type and length
• Upload after make DCP checkbox

In addition to this, the settings (but not the filenames) of any content in the template are stored, as discussed above. The status of the Keep video and subtitles in sequence checkbox from the timeline is also preserved.
Chapter 9

Export

As well as creating DCPs from the content you specify, DCP-o-matic can also export projects to ProRes and MP4 files. This is most often useful to convert DCPs to a file that is smaller and easier to play back.

To convert a DCP to ProRes or MP4, the first step is start a new project and import the DCP (see Chapter 5). Then, choose Export... from the Jobs menu to open the export dialogue, as shown in Figure 9.1.

![Figure 9.1: Export dialogue](image)

From this dialogue you can select the required output format, output file and, in the case of MP4, the quality of the output file. Higher quality files will, of course, be larger.

You can also choose whether to mix down multichannel sources to stereo and whether you want to write separate reels to separate files.
Chapter 10

Encryption

DCP’s do not have to be encrypted, but they can be. This chapter discusses the basic principles of DCP encryption, and how DCP-o-matic can create encrypted DCPs and KDMs for them.

10.1 Basics

DCPs can be encrypted. This means that the picture and sound data are encoded in such a way that only cinemas ‘approved’ by the DCP’s creators can read them. In particular, this means copies of the DCP can be distributed by insecure means: if a bad person called Mallory obtains a hard drive containing an encrypted DCP, there is no way that he can play it. Only those cinemas who receive a correct key delivery message (KDM) can play the DCP.

10.1.1 How it works

This section attempts to summarise how DCP encryption works. You can skip it if you like. You may need some knowledge of encryption methods to understand it.

We suppose that we are trying to send a DCP to Alice’s cinema without a troublemaker called Mallory being able to watch it himself.

There are two main families of encryption techniques. The first, symmetric-key encryption, allows us to encode some data using some numeric key. After encoding, no-one can decode the data unless they know the key.

The first step in a DCP encryption is to encode its data with a random key using symmetric-key encryption. The encrypted DCP can then be sent anywhere, safe in the knowledge that even if Mallory got hold of a copy, he could not decrypt it.

Alice, however, needs to know the key so she can play the DCP in her cinema. A simple approach might be for us to send Alice the key. However, if Mallory can intercept the DCP, he might also be able to intercept our communication of the key to Alice. Furthermore, if Alice happened to know Mallory, she could just send him a copy of the key.

The clever bit in the process requires the use of public-key encryption. With this technique we can encrypt a block of data using some ‘public’ key. That data can then only be decrypted using a corresponding private key which is different to the public key. The private and public keys form a pair which are related mathematically, but it is extremely hard (or rather, virtually impossible) to derive the private key from the public key.

Public-key encryption allows us to distribute the DCP’s key to Alice securely. The manufacturer of Alice’s projector generates a public and private key. They hide the private key inside the projector where no-one can read it. They then make the public key available to anyone who is interested.

DCP-o-matic has a similar arrangement except that it stores its private keys in the user’s configuration file. See Section 5.2 for details of how to share DCP-o-matic’s certificate so that others can make encrypted DCPs for DCP-o-matic.
We take our DCP’s symmetric key and encrypt it using the public key of Alice’s projector. We send the result to Alice over email (using a format called a Key Delivery Message, or KDM). Her projector then decrypts our message using its private key, yielding the magic symmetric key which can decrypt the DCP.

If is fine if Mallory intercepts our email to Alice, since the only key which can decrypt the message is the private key buried inside Alice’s projector. The projector manufacturer is very careful that no-one ever finds out what this key is. Our DCP is secure: only Alice can play it back, since only her projector knows the key (even Alice does not).

10.2 Encryption using DCP-o-matic

There are two steps to distributing an encrypted DCP. First, the DCP’s data must be encrypted, and secondly KDMs must be generated for those cinemas that are allowed to play the DCP.

The first part is simple: ticking the Encrypted box in the DCP tab will instruct DCP-o-matic to encrypt the DCP that it makes using a random key that DCP-o-matic generates. The key will be written to the film’s metadata file, which should be kept secure.

A DCP that is generated with the Encrypted box ticked will not play on any projector as-is (it will be marked as ‘locked’, or whatever the projector manufacturer’s term is).

The second part of distributions is to generate KDMs for the cinemas that you wish to allow to play your DCP. There are two approaches to this within DCP-o-matic: using the project, or using a DKDM. These approaches are now described in turn.

10.2.1 Creating KDMs from a DCP-o-matic project

You can create KDMs from inside a DCP-o-matic project using the Make KDMs option on the Jobs menu. This will open the KDM dialogue box, as shown in Figure 10.1.

![Figure 10.1: KDM dialog](image)

In order to generate KDMs for a particular projector, you need to know its certificate. These are usually made available by the projector manufacturers as text files with a .pem extension.
DCP-o-matic can store these certificates along with details of their cinemas and screens within those cinemas. Each screen has a certificate for its projector (and optionally certificates for other trusted devices, such as the sound processor). DCP-o-matic can generate KDMs for any screens that it knows about.

To add a cinema, click Add Cinema... This opens a dialogue box into which you can enter the cinema’s name, and optionally an email address. This email address can be used to get DCP-o-matic to deliver KDMs via email.

Once you have added a cinema, select it by clicking on its name, then click Add Screen.... The resulting dialogue allows you to enter a name for the screen and load in its certificate from a file. The certificate should be in SHA256 PEM format.

Alternatively, certificates for projection systems made by some manufacturers can be downloaded from databases provided by the manufacturer. Currently this is supported for Doremi, Dolby, Barco, Christie and GDC equipment (through downloading Barco, Christie or GDC certificates requires you to have an appropriate account set up in DCP-o-matic’s preferences). If you are targeting a screen with equipment by one of these manufacturers you can click Download then enter the serial number of the server in the screen and click Download again and, all being well, the certificate will be fetched. Most cinema projection or technical departments will know these serial numbers.

Note that the reliability of the manufacturers’ certificate databases cannot be guaranteed. It is vital that KDMs are tested by the destination cinema will in advance of show time to identify any problems.

Once you have set up all the screens that you need KDMs for, select the CPL that you want to create the KDM for. You can use the drop-down list to select the CPLs in the current film project, or load a CPL from somewhere else. Select the cinemas and/or screens that you want KDMs for and fill in the start and end dates and times.

You must also select the type of KDM that you want to generate. If in doubt, use Modified Transitional 1.

The differences between the three KDM types are fairly subtle. DCI Specific and DCI Any add a <ContentAuthenticator> tag to the KDM which allows the exhibitor to check that the DCP and KDM have come from a bona-fide source. In addition, DCI Specific adds information on trusted devices to the KDM. This allows the KDM creator to specify devices (such as sound processors) that are allowed to use keys delivered by the KDM. At present it is not clear how widely the DCI Specific and DCI Any features are supported (or even tolerated) by servers so you are advised to use Modified Transitional 1.

Finally, choose what you want to do with the KDMs. They can be written to disk, to a location that you can specify by clicking Browse. Alternatively, if you choose Send by email the KDMs will be zipped up and emailed to the appropriate cinema email addresses. Click Make KDMs to generate the KDMs.

10.2.2 Creating KDMs using a DKDM

It can be inconvenient to need a whole DCP-o-matic project just to create KDMs for its film. Perhaps you want to archive the project to save space, or create KDMs on a different machine. In such situations it is easier to use a DKDM. This is a normal KDM, but instead of being targeted at a projection system (to allow it to decrypt the content) it is targeted at a particular user’s certificate. This means that the certificate owner can create new KDMs for other users. The DKDM holds everything that is required to create further KDMs.

Sometimes it is useful to create DKDMs that can be used by DCP-o-matic. If you create such a DKDM you can keep it and then, at any point in the future, use DCP-o-matic’s standalone KDM creator to make KDMs for the DKDM’s film for any cinema.

In other cases a DKDM is sent to a 3rd party so that they can create KDMs for your films. This can be useful if, for example, you have a distributor who provides 24-hour KDM support to cinemas and can create KDMs for anybody that requires them at short notice.

To create a DKDM for DCP-o-matic, open your encrypted project and select Make DKDM for DCP-o-matic... from the Jobs menu. Select the CPL that you want to make the DKDM for and click OK. This DKDM will then be available in the KDM creator. This is a separate program which you can start from the same place that you start the ‘normal’ DCP-o-matic. Its window is shown in Figure 10.2.
To create KDMs, select the cinema(s) and/or screens that you want KDMs to be created for, the date range, the DCP that the KDMs are for and the destination for the KDMs and click Create KDMs.

By default the DKDM list will list any DCPs for which you have clicked Make DKDM for DCP-o-matic in the main DCP-o-matic program. If you have other DKDMs you can add them by clicking Add... and specifying the file containing the DKDM.

If another organisation wants to send you a DKDM they will ask you for a target certificate. You can get DCP-o-matic’s target certificate by opening Preferences and clicking Export DCP decryption certificate... in the Keys tab.

### 10.3 Encryption keys

You must be careful when using encryption not to lose important keys.

If you are making KDMs from a DCP-o-matic film you must ensure that you have a backup of the metadata.xml file from the project, as well as the DCP itself.

If you are using a DKDM you must ensure that you have a backup of DCP-o-matic’s config.xml file, since it contains the only key which can decrypt the DKDM. The config.xml file location depends on your operating system; possible locations are listed in Chapter 19.

### 10.4 Should I encrypt?

The question of whether encryption is appropriate for a given project is a tricky one.
On the one hand, if you distribute an unencrypted DCP it is easy for anybody to take it and do whatever they want with its contents. They could use DCP-o-matic to convert it to a MP4, show it in their cinema, or even edit and redistribute it in ways that you do not like.

Encryption prevents this, but brings its own problems. It will be impossible for a cinema to screen your DCP unless they have the correct KDM. This is easy enough if things work as they should, but problems can occur. For example, cinemas may substitute broken playout servers with new ones without telling you: then the KDM that you sent them will be invalid, and a new one required. If the cinema can’t get in touch with you, or somebody else who can create a new KDM, they can’t screen your DCP. Often these problems are only discovered very close to showtime, with little time for fixes.

If you are distributing encrypted DCPs widely it is worth thinking about who will make the KDMs, and who will provide quick-response technical support. It may be a good idea to engage a company who can provide such services.

### 10.5 Encryption overview

![Figure 10.3: Overview of encryption](image-url)


Chapter 11

Preferences

DCP-o-matic provides preferences which can be used to modify its behaviour. They are described in this chapter. Preferences can be edited by choosing Preferences... from the Edit menu. This opens a dialogue which is split into eleven tabs.

11.1 General

The general tab is shown in Figure 11.1.

![General preferences](image)

Figure 11.1: General preferences

11.1.1 Language

If you tick the Set Language checkbox and choose a language from the list, that language will be used for DCP-o-matic. You will need to restart DCP-o-matic to see the new language.
11.1.2 Interface complexity

Choose Simple to see a cut-down, simplified interface or Full to see DCP-o-matic’s full interface.

11.1.3 Number of threads DCP-o-matic should use

When DCP-o-matic is encoding DCPs it can use multiple parallel threads to speed things up. Set this value to the number of threads DCP-o-matic should use. This should normally be the number of processors (or processor cores) in your machine. DCP-o-matic will try to set this up correctly when you run it for the first time.

11.1.4 Number of threads DCP-o-matic encode server should use

This is the number of threads that the encode server should use when it is running and helping another copy of DCP-o-matic to speed up its encode.

11.1.5 Configuration file

This is the location of DCP-o-matic’s configuration file on disk. You can use this to share configuration between several copies of DCP-o-matic, across a network share, for instance.

11.1.6 Cinema and screen database file

This option allows you to change the file that DCP-o-matic uses to store details of the cinemas and screens used to make KDMs.

11.1.7 Play sound via

The checkbox to the left of Play sound enables or disables DCP-o-matic use of sound. On some machines there will be multiple options in the drop-down menu to decide how the sound should be played.

11.1.8 Integrated loudness

If Find integrated loudness, true peak and loudness range when analysing audio is ticked, DCP-o-matic will do extra work when analysing audio. Leave this ticked if the extra parameters are useful to you. If not, untick it and audio analysis will be faster.

11.1.9 Automatically analyse content audio

If this checkbox is ticked an audio analysis will be run whenever content is added that contains sound.

11.1.10 Updates

The Check for updates on startup option, if enabled, will tell DCP-o-matic to check on dcpomatic.com to see if there any newer versions of DCP-o-matic then the one you are running. If so, a dialogue box will open with a link to download the new version.

The Check for testing updates as well as stable ones option will also check for test updates as well as those that are formally ‘released’. This is useful if you like to live on the bleeding edge!
11.1.11 **Issuer and creator**

With these controls you can set the issuer and creator strings that will be put into the DCPs which you create.

11.2 **Defaults**

The defaults tab is shown in Figure 11.2.

![Defaults preferences](image)

Figure 11.2: Defaults preferences

The options in this tab simply allow you to set up default values for various properties of new films.

11.3 **Servers**

The servers tab is shown in Figure 11.3.
If **Use all servers** is ticked DCP-o-matic will locate encoding servers automatically (see Chapter 13).

Instead of this (or in addition) servers can be specified explicitly. To add a server, click **Add...** and enter the host name or IP address of the server to use.

### 11.4 Keys

The Keys tab (shown in Figure 11.4) has controls related to the keys and certificates used in some parts of DCP creation.

![Figure 11.4: Keys preferences](image)

- **Export KDM decryption certificate...** allows you to save the certificate that DCP-o-matic uses when decrypting KDMs that you give it. Use this option if somebody wants to make a KDM for you and asks for your certificate.

- **Export all KDM decryption settings...** exports a file which contains all the DCP-o-matic settings related to the use of KDMs supplied by other people. Use this button and **Import all KDM decryption settings...** to transfer settings between different copies of DCP-o-matic so that they can both use the same KDMs.

- The two **Advanced...** buttons open advanced dialogue boxes for detailed manipulation of DCP-o-matic's certificate chains.
11.5 Advanced keys settings

At the top of the Advanced dialogue for signing DCPs and KDMs is the chain of certificates that will be used to sign DCPs and KDMs. DCP-o-matic creates a random chain when you first run it and if you are happy to use this chain you can ignore the preferences. Otherwise, you can add or remove certificates from the chain using the Add... and Remove buttons.

If you want DCP-o-matic to re-create the certificate chain (using new, random certificates) click Re-make certificates and key... and specify your organisation and common names in the dialogue box that opens.

Underneath the certificate chain is the private key that corresponds to the leaf certificate in the chain. You can specify your own private key by clicking Import.... You must do this if you change the leaf certificate, so that the leaf private key corresponds to the public key held in the leaf certificate.

At the top of the Advanced dialogue for decrypting DCPs is the chain and key which is used by DCP-o-matic when you import an encrypted DCP as a piece of content. The leaf certificate of this chain contains the public key that should be used when targeting a KDM at DCP-o-matic.

Clicking Export chain... will export the whole certificate chain.

11.6 TMS

The TMS tab (shown in Figure 11.5) gives some options for specifying details about your theatre management system (TMS). If you do this, and your TMS accepts SSH or FTP connections, you can upload DCPs directly from DCP-o-matic to the TMS using the Send DCP to TMS option in the Jobs menu.

```
Figure 11.5: TMS preferences
```

Protocol should be set to SCP or FTP as appropriate for your TMS. We know that the Arts Alliance Media (AAM) and the Doremi ranges uses SCP connections, and that Dolby’s TMSs use FTP. Do let us know if you use any other type of TMS with the Send DCP to TMS feature.

TMS IP address should be set to the IP address of your TMS, TMS target path to the place that DCPs should be uploaded to (which will be relative to the home directory of the SSH or FTP user). Finally, the user name and password are the credentials required to log into the TMS via SSH or FTP.

Note that for this to work on Doremi servers you will need to set the PasswordAuthentication option in your server’s sshd_config to yes.

11.7 Email

The Email tab is shown in Figure 11.6.
These settings are used when DCP-o-matic sends emails. **Outgoing mail server** should be the host name of a mail (SMTP) server that DCP-o-matic can use. You can also specify the port that DCP-o-matic should use. **User name** and **Password** are the credentials that are required to send email through the server you have specified.

11.8 KDM email

The KDM email tab is shown in Figure 11.7.

This is a template for the email that is used to send KDMs out to cinemas. You can change it to say whatever you like. A few ‘magic’ strings will be replaced by information from the KDM that is being sent; these strings are shown in Table 11.1.
Table 11.1: ‘Magic’ KDM strings

| $CPL_NAME | DCP title |
| $CINEMA_NAME | Cinema name |
| $SCREENS | Name of screen or screens that KDMs are being generated for |
| $START_TIME | The time from which the KDMs are valid |
| $END_TIME | The time until which the KDMs are valid |

The **Reset to default** text will replace the current KDM email with DCP-o-matic’s default.

## 11.9 Accounts

The Accounts tab is shown in Figure 11.8.

![Accounts preferences](image)

Figure 11.8: Accounts preferences

DCP-o-matic can download projector certificates from the Barco, Christie and GDC websites if you have the appropriate credentials. Enter your usernames and passwords.

## 11.10 Notifications

The Notifications tab is shown in Figure 11.9.
DCP-o-matic can notify the user when jobs have completed. These notifications can be either or both of a message box on-screen (if Message box is ticked) and email (if Email is ticked). If you enable email notifications you can fill in the details of the emails you want to send.

The bottom box in the tab is the contents of the email that should be sent. DCP-o-matic will replace the ‘magic’ strings $JOB_NAME and $JOB_STATUS in the with the details of the job that has completed.

### 11.11 Cover sheet

The DCP cover sheet configuration is shown in Figure 11.10.
This is a template for the cover sheet that is written next to every DCP that DCP-o-matic creates. You can change it to say whatever you like. A few ‘magic’ strings will be replaced by information from the DCP that has been made:

<table>
<thead>
<tr>
<th>String</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$CPL_NAME</td>
<td>DCP title</td>
</tr>
<tr>
<td>$TYPE</td>
<td>DCP content type (e.g. feature, trailer...)</td>
</tr>
<tr>
<td>$CONTAINER</td>
<td>The container ratio (e.g. flat, scope...)</td>
</tr>
<tr>
<td>$AUDIO</td>
<td>Details of the audio channels</td>
</tr>
<tr>
<td>$AUDIO_LANGUAGE</td>
<td>Audio language</td>
</tr>
<tr>
<td>$SUBTITLE_LANGUAGE</td>
<td>Subtitle language</td>
</tr>
<tr>
<td>$LENGTH</td>
<td>DCP length in hours, minutes and seconds</td>
</tr>
<tr>
<td>$SIZE</td>
<td>DCP size in gigabytes</td>
</tr>
</tbody>
</table>

Table 11.2: ‘Magic’ cover sheet strings

The Reset to default text will replace the current cover sheet with DCP-o-matic’s default.

11.12 Advanced

The advanced preferences are shown in Figure 11.11.
**Maximum JPEG2000 bandwidth** specifies the maximum bit-rate of JPEG2000 that DCP-o-matic will allow you to create. You are advised to leave this at 250Mbit/s in normal use for maximum DCP compatibility.

**Allow any DCP frame rate** removes the limits on the DCP video frame rates that DCP-o-matic will create. This may be useful for experimentation. Again, you are strongly advised to leave this unticked for normal use.

**Only servers encode** makes DCP-o-matic encode JPEG2000 data only on encoding servers and not on the host. We suggest you leave this unticked unless you have a good reason to do otherwise.

With the filename format fields you can adjust the filenames that are used for metadata (CPL and PKL files) and assets (MXF and subtitle files). Below each field there is a list of the ‘magic’ values that you can use in the format and an example of a filename that you might see with your current settings.

The four checkboxes labelled **Log** control what sort of messages DCP-o-matic writes to its log file when creating a DCP. It is useful to leave **General, Warnings and Errors** ticked as this makes the log files useful for tracking down bugs.

The **Timing** checkbox will enable extra log entries to allow developers to investigate and optimise the speed of DCP-o-matic. It will significantly increase the size of the log files that are generated, so in normal use it is best to leave this unticked.
Chapter 12

Frame rates

In an ideal world, a DCP would be created using content at the same video frame and audio sampling rates as the DCP. This is not, however, always possible.

12.1 DCP frame rate limitations

There are some limitations to video and audio frame rates in DCPs. This is complicated by the fact that not all projectors will play DCPs at the same frame rates. It is possible to create a DCP which one projector will play fine, but another (of a different type) will refuse to play.

12.1.1 Guaranteed rates

The only rates that are guaranteed to work on all DCI projectors are 24 frames per second (fps) for video and 48kHz for audio. If you are sending DCPs to unknown places it is wise to consider using these rates if at all possible.

12.1.2 Other often-supported rates

Many projectors now in the wild support additional video frame rates: 25, 30, 48, 50 and 60 fps.

12.1.3 Adapting content to fit the DCP rate

DCP-o-matic has a few tricks to allow you to use content that is not in one of the ‘approved’ rates.

Audio is easy: DCP-o-matic can resample to 48kHz from any source rate with minimal loss in quality.

Video rate conversion is harder. DCP-o-matic’s basic strategy to deal with a non-supported content rate is to run it at the wrong speed, and to adjust the audio to keep it in sync.

Let us consider the example of a 25fps source for which you want to create a 24fps DCP. DCP-o-matic will put the frames from the source directly into the DCP without modification, but will tell the projector to play them back at 24fps. This means that the DCP’s video will run slightly slower than the original.

If DCP-o-matic did nothing else, the result of this would be that the audio would be running at the original speed with the video running slowly. Hence the audio would drift slowly out of sync. To avoid this, DCP-o-matic also resamples the audio such that the projector will play it too slow by the same amount. Hence it will sound slightly different but will remain in sync with the video.

For very low or high frame rates, DCP-o-matic can also skip or duplicate frames.
12.2 Setting up

The Frame Rate control in the DCP tab sets the video frame rate that the DCP will use. Clicking Use best sets the rate to what DCP-o-matic thinks is the best for your content. With this button, DCP-o-matic assumes that the most commonly-working frame rates (24, 25 and 30fps) are allowed.

After this, the Video tab for each piece of content will give a summary of what DCP-o-matic is doing with that content.

If you want to experiment with other non-standard frame rates, you can do so by ticking the Allow any DCP frame rate in the Advanced tab of the preferences dialogue (see the Advanced preferences). You are strongly advised to use this only on your own equipment, and only for experimentation purposes.
Chapter 13

Encoding servers

One way to increase the speed of DCP encoding is to use more than one machine at the same time. An instance of DCP-o-matic can offload some of the time-consuming JPEG2000 encoding to any number of other machines on a network. To do this, one ‘master’ machine runs DCP-o-matic, and the ‘server’ machines run a small program called dcpomatic_server.

The master and server machines do not need to be the same type, so you can mix Windows PCs, Macs and Linux machines as you wish.

13.1 Running the servers

There are two options for the encoding server; dcpomatic_server_cli, which runs on the command line, and dcpomatic_server, which has a simple GUI. The command line version is well-suited to headless servers, especially on Linux, and the GUI version works best on Windows where it will put an icon in the system tray.

To run the command line version, simply enter:

```
dcpomatic2_server_cli
```

at a command prompt. If you are running the program on a machine with a multi-core processor, you can run multiple parallel encoding threads by doing something like:

```
dcpomatic2_server_cli -t 4
```

to run 4 threads in parallel.

To run the GUI version on windows, run the ‘DCP-o-matic encode server’ from the start menu. An icon will appear in the system tray; right-click it to open a menu from whence you can quit the server or open a window to show its status.

If you would rather not bother installing DCP-o-matic on your server computers, the other option is to use the live-CD image that you can download from the DCP-o-matic web site.

Either burn the image to CD, or write it to a USB stick (using something like unetbootin). Boot a PC from the CD or USB stick and it becomes a DCP-o-matic server without touching your standard operating system install.

13.2 Setting up DCP-o-matic

DCP-o-matic periodically looks on the local network for servers. Any that it finds are given work to do during encodes. Selecting Encoding Servers from the Tools menu brings up a window which shows that servers that DCP-o-matic has found.
13.3  Some notes about encode servers

DCP-o-matic does not mind if servers come and go; if a server disappears, DCP-o-matic will stop sending work to it, and will check it every minute or so in case it has come back online.

You will probably find that using a 1Gb/s or faster network will provide a significant speed-up compared to a 100Mb/s network.
Chapter 14

Generated files

DCP-o-matic generates a number of files as it makes a DCP. Figure 14.1 shows the files that might be generated after you have created a DCP for a film called ‘DCP Test’.

![Diagram of generated files]

Figure 14.1: Creating a new film
The DCP Test folder is the one that you specify when you select the New Film option from DCP-o-matic’s menu. Everything is stored inside this folder.

DCP-o-matic generates some working files as it goes along. These are as follows:

- **log** is a list of notes that DCP-o-matic makes as it goes along. This can be useful for debugging purposes if something goes wrong.
- **metadata** stores the settings that you have made for this film: things like cropping, output format and so on.
- **video** is where DCP-o-matic writes the DCP’s video data as it encodes it.
- **analysis** is used to keep the results of audio analysis runs.
- **info** contains details of each video frame that DCP-o-matic has written so far. This is used when an encoding operation is interrupted and DCP-o-matic must resume it.

Following this is the DCP itself: DCP-TEST_EN-XX_UK-U_51_2K_CSY_20130218_CSY_OV. This contains some small XML files, which describe the DCP, and two large MXF files, which contain the DCP’s audio and video data. It may also contain subtitles in either XML or MXF format. This folder (DCP-TEST_EN-XX_...) is what you should ingest, or pass to the cinema which is showing your DCP.
Chapter 15

Command-line tools

DCP-o-matic includes some tools which allow DCP creation from the command line or from scripting languages. This chapter covers the use of those tools.

There are three command-line tools in DCP-o-matic. dcpomatic2_create creates film directories, with the associated metadata, from a list of content files. Then dcpomatic2_cli runs the transcode process on these film directories. Finally, dcpomatic2_kdm_cli can be used to create KDMs.

Some applications will benefit from setting up the films using the main DCP-o-matic GUI and then using dcpomatic2_cli to do the encode. This allows, for example, setup on a relatively low-powered machine before running the encode on a higher-powered headless server.

15.1 dcpomatic2_create

The syntax for dcpomatic2_create is:

dcpomatic2_create [OPTION] <CONTENT> [[OPTION] <CONTENT> ...]

[CONTENT] are the files or folders that you want to use in the DCP. They can be:

- ‘Movie’ files in almost any common format (e.g. MP4, MOV, MKV, etc.)
- A folder containing and image sequence in almost any common format (e.g. TIFF, DPX etc.)
- Sound files (e.g. WAV, MP3, AIFF)
- Subtitles files (e.g. .srt, DCP XML, .ssa etc.)

The options are:

- -v, --version — show DCP-o-matic version
- -h, --help — show this help
- -n, --name <name> — film name
- -t, --template <name> — template name
- -e, --encrypt — make an encrypted DCP
- -c, --dcp-content-type <type> — FTR, SHR, TLR, TST, XSN, RTG, TSR, POL, PSA or ADV
- -f, --dcp-frame-rate <rate> — set DCP video frame rate (otherwise guessed from content)
- --container-ratio <ratio> — 119, 133, 137, 138, 166, 178, 185 or 239
For example, to setup a film using a MP4 file you might do:

dcpomatic2_create -o my_film --container-ratio 185 --content-ratio 185 -c FTR -n "My Film" Stuff.mp4

This will create a folder called `my_film` which is ready for a DCP to be made by dcpomatic2_cli.

dcpomatic2_create will use any default settings that you have configured in the main DCP-o-matic preferences.

15.2 dcpomatic2_cli

The syntax for dcpomatic2_cli is:

dcpomatic2_cli [OPTION] [FILM]

• --version — show DCP-o-matic version
• -h, --help — show this help
• -f, --flags — show flags passed to C++ compiler on build
• -n, --no-progress — do not print progress to stdout
• -r, --no-remote — do not use any remote servers
• -t, --threads — specify number of local encoding threads (overriding configuration)
• -j, --json <port> — run a JSON server on the specified port
• -k, --keep-going — keep running even when the job is complete
• -s, --servers <file> — specify servers to use in a text file
• -l, --list-servers — just display a list of encoding servers that DCP-o-matic is configured to use; don’t encode
• -d, --dcp-path — echo DCP’s path to stdout on successful completion (implies -n)
• -c, --config <dir> — directory containing config.xml and cinemas.xml
• --dump — just dump a summary of the film’s settings; don’t encode

For example, to encode a film called `my_film` you might do:

dcpomatic2_cli my_film
The syntax for `dcpomatic2_kdm_cli` is:
`dcpomatic2_kdm_cli [OPTION] <FILM|CPL-ID>

- `-h, --help` — show this help
- `-o, --output` — output file or directory
- `-k, --filename-format` — filename format for KDMs
- `-z, --container-name-format` — filename format for ZIP containers
- `-f, --valid-from` — valid from time (in local time zone of the cinema) (e.g. “2013-09-28 01:41:51”) or “now”
- `-t, --valid-to` — valid to time (in local time zone of the cinema) (e.g. “2014-09-28 01:41:51”)
- `-d, --valid-duration` — valid duration (e.g. “1 day”, “4 hours”, “2 weeks”)
- `-F, --formulation` — modified-transitional-1, multiple-modified-transitional-1, dci-any or dci-specific [default modified-transitional-1]
- `-a, --disable-forensic-marking-picture` — disable forensic marking of pictures essences
- `-a, --disable-forensic-marking-audio` — disable forensic marking of audio essences (optionally above a given channel, e.g 12)
- `-z, --zip` — ZIP each cinema’s KDMs into its own file
- `-v, --verbose` — be verbose
- `-c, --cinema` — specify a cinema, either by name or email address
- `-S, --screen` — screen description
- `-C, --certificate` — file containing projector certificate
- `-T, --trusted-device` — file containing a trusted device’s certificate
- `--list-cinemas` — list known cinemas from the DCP-o-matic settings
- `--list-dkdm-cpls` — list CPLs for which DCP-o-matic has DKDMs
Chapter 16

Loose ends

This chapter collects a few notes on bits of DCP-o-matic that do not fit elsewhere in the manual.

16.1 Resuming encoder

If you cancel a DCP encoding run half-way through, or your computer crashes... fear not. DCP-o-matic takes care to ensure that, in most cases, it can resume encoding from where it left off. When you re-start a DCP creation, using the same settings as a previous run, DCP-o-matic will first check that the existing picture frames are correct, and then resume from where it left off. The checking of existing frames does take some time, but it is much faster than running a full re-encode.

This resumption is achieved by writing a digest (hash) to disk for every image frame that is written. On resumption, the existing MXF file for image data is read and its contents checked against the hashes.
Chapter 17

Common tasks

This chapter describes how to carry out some commonly-required tasks with DCP-o-matic. The full details are elsewhere in the manual: here we just discuss different approaches to these tasks and how to carry them out.

17.1 Adding subtitles to an existing DCP

You have three options:

- Make a “Version File” (VF) DCP.
- Make a complete DCP with projector-added subtitles.
- Make a complete DCP with burnt-in subtitles.

Making a VF DCP is usually the best option. This will be a very small DCP which contains only the subtitles: it refers to your existing DCP for the picture and sound. The projectionist will ingest both the existing and VF DCPs and play back the VF. The advantages of this approach are that the VF is very quick to generate, and small in size, making it easy to distribute. This is especially useful if you have to make VF DCPs in many different languages.

Making a complete DCP with projector-added subtitles gives you a new, single DCP which the projectionist can ingest and play. It will be the same size as your existing DCP, and fairly quick to create. This approach relies on the projector (or server) to create the subtitles and overlay them on the image, which mostly works well but is not 100% reliable.

Making a complete DCP with burnt-in subtitles gives you a new, single DCP but with the subtitles rendered by DCP-o-matic and copied into your image. This is slower to create than a DCP with projector-added subtitles as every video frame with a subtitle must be re-encoded. The advantage of this approach is that it is less likely to go wrong, especially if you are using unusual subtitle positioning or character sets.

17.1.1 Making a VF DCP

- Start a new DCP-o-matic film.
- Click Add DCP... and specify your existing DCP’s folder.
- Go to the DCP tab and choose Split by video content for Reel type.
- Go to the Video and Audio tabs in turn and tick the Use this DCP’s audio as OV and make VF checkboxes.
- Add your subtitles to the film in whatever format you have.
- Check the subtitle appearance in the preview; it will be slow to respond as it is having to decompress images from the existing DCP.
- Choose Make DCP from the menu.
17.1.2 Making a complete DCP with projector-added subtitles

- Start a new DCP-o-matic film.
- Click Add DCP... and specify your existing DCP’s folder.
- Add your subtitles to the film in whatever format you have.
- Check the subtitle appearance in the preview; it will be slow to respond as it is having to decompress images from the existing DCP. Adjust the appearance using controls in the Subtitle tab if required.
- Choose Make DCP from the menu.

17.1.3 Making a complete DCP with burnt-in subtitles

- Start a new DCP-o-matic film.
- Click Add DCP... and specify your existing DCP’s folder.
- Add your subtitles to the film in whatever format you have.
- Go to the Subtitle tab and tick the Burn subtitles into image checkbox.
- Check the subtitle appearance in the preview; it will be slow to respond as it is having to decompress images from the existing DCP. Adjust the appearance using controls in the Subtitle tab if required.
- Choose Make DCP from the menu.

17.2 Adding soundtracks or subtitles in different languages

If you have a film that is to be dubbed or subtitled in several languages, the best approach with DCP-o-matic is as follows:

- Make a DCP with the common elements (perhaps just the video, or maybe the video and sound); this is known as the Original Version (OV).
- For each language, make a new Version File (VF) DCP which refers to the OV.

Once you have done this, you send the OV DCP to every cinema and then the appropriate VF to each cinema depending on what language they want to play the film in. The projectionist ingests both DCPs and then plays the VF.

The advantage of this approach is that the VF DCPs are much smaller than the OV since they only have the language-specific parts. If you are just changing the subtitles you can often ship the OV by normal transport means (e.g. a hard drive or high-speed download) and send the VF by email.

The full details of OV and VF files are discussed in Section 5.3.2. The steps can be summarised as follows:

- Create a new DCP-o-matic project for the OV, as normal, adding video and perhaps sound. Make the DCP.
- Create a new DCP-o-matic project for the VF.
- Use Add folder... to add your OV DCP to the project.
- Select the video tab and tick Use this DCP’s video as OV and make VF (you may need to select By video content for Reel type in the DCP tab).
- Do the same in the Audio tab if your OV has audio.
- Add your language-specific audio and/or subtitles and Make DCP.
Chapter 18

Playing and verifying DCPs

DCP-o-matic includes a DCP player, and although it requires a very high-speed CPU to play DCPs in full resolution, it can also play DCPs at reduced resolutions with slower CPUs.

To use the player, start DCP-o-matic Player, and load a DCP using the Open option on the File menu.

If you load a VF and/or encrypted DCP you can add your OV and/or KDM using the appropriate options on the File menu.

During playback the Performance area at the bottom right of the window will give details of how many frames are being dropped; these are frames that were not decoded from the DCP quickly enough. If this number is high you can increase performance at the cost of rendering quality by choosing an option from the View menu. If you set the player to decode at less than full resolution the DCP’s data will be decoded at this lower resolution, which is quicker than decoding at full resolution.

The player also offers a simple DCP validator. To check a DCP, open it and then select Verify DCP from the Tools menu. This will run some basic checks to see if the DCP meets the required standards.
Chapter 19

Configuration files

Most of DCP-o-matic’s configuration is stored in an XML file called config.xml. This is stored in different places depending on your operating system:

- Windows: c:\Users\your_user_name\AppData\Local\dcpomatic
- OS X: /Users/your_user_Name/Library/Preferences/com.dcpomatic/2
- Linux: ~/.config/dcpomatic2

Possible XML tags are as follows:

- `<Version>` — The version number of the configuration file format.
- `<MasterEncodingThreads>` — Number of encoding threads to use when running as master.
- `<ServerEncodingThreads>` — Number of encoding threads to use when running as server.
- `<DefaultDirectory>` (optional) — Default directory when creating a new film in the GUI.
- `<ServerPortBase>` — Port number to use for frame encoding requests. `ServerPortBase + 1` and `ServerPortBase + 2` are used for querying servers. `ServerPortBase + 3` is used by the batch converter to listen for job requests.
- `<UseAnyServers>` — 1 to broadcast to look for encoding servers to use, 0 to use only those configured.
- `<Server>` (optional) — IP address or hostname of an encoding server to use; you can use as many of these tags as you like.
- `<OnlyServersEncode>` — 1 to set the master to do decoding of source content no JPEG2000 encoding; all encoding is done by the encoding servers. 0 to set the master to do some encoding as well as coordinating the job.
- `<TMSProtocol>` — Protocol to use to copy files to a TMS; 0 to use SCP, 1 for FTP.
- `<TMSIP>` — IP address of TMS.
- `<TMSPath>` — Path on the TMS to copy files to.
- `<TMSUser>` — Username to log into the TMS with.
- `<TMSPassword>` — Password to log into the TMS with.
- `<CinemaSoundProcessor>` (optional) — Identifier of the type of cinema sound processor to use when calculating gain changes from fader positions. Currently can only be dolby_cp750.
- `<Language>` (optional) — Language to use in the GUI e.g. fr_FR.
- `<DefaultContainer>` (optional) — ID of default container to use when creating new films (185, 239 or 190).
• `<DefaultScaleTo>` (optional) — ID of default ratio to scale content to when creating new films (see `DefaultContainer` for IDs).

• `<DefaultDCPContentType>` (optional) — Default content type to use when creating new films (FTR, SHR, TLR, TST, XSN, RTG, TSR, POL, PSA or ADV).

• `<DefaultDCPAudioChannels>` — Default number of audio channels to use when creating new films.

• `<DCPIssuer>` — Issuer text to write into CPL files.

• `<DCPIssuer>` — Creator text to write into CPL files.

• `<DefaultUploadAfterMakeDCP>` — 1 to default to uploading to a TMS after making a DCP, 0 to default to no upload.

• `<ISDCFMetadata>` — Default ISDCF metadata to use for new films; child tags are `<ContentVersion>`, `<AudioLanguage>`, `<SubtitleLanguage>`, `<Territory>`, `<Rating>`, `<Studio>`, `<Facility>`, `<TempVersion>`, `<PreRelease>`, `<RedBand>`, `<Chain>`, `<TwoDVersionOfThreeD>`, `<MasteredLuminance>`.

• `<DefaultStillLength>` — Default length (in seconds) for still images in new films.

• `<DefaultJ2KBandwidth>` — Default bitrate (in bits per second) for JPEG2000 data in new films.

• `<DefaultAudioDelay>` — Default delay to apply to audio (positive moves audio later) in milliseconds.

• `<DefaultInterop>` — 1 to default new films to Interop, 0 for SMPTE.

• `<DefaultKDMDirectory>` (optional) — Default directory to write KDMs to.

• `<MailServer>` — Hostname of SMTP server to use.

• `<MailPort>` — Port number to use on SMTP server.

• `<MailProtocol>` — Protocol to use on SMTP server (Auto, Plain, STARTTLS or SSL)

• `<MailUser>` — Username to use on SMTP server.

• `<MailPassword>` — Password to use on SMTP server.

• `<KDMSubject>` — Subject to use for KDM emails.

• `<KDMFrom>` — From address to use for KDM emails.

• `<KDMCC>` — CC address to use for KDM emails; you can use as many of these tags as you like.

• `<KDMBCC>` — BCC address to use for KDM emails.

• `<KDEmail>` — Text of KDM email.

• `<NotificationSubject>` — Subject to use for notification emails.

• `<NotificationFrom>` — From address to use for notification emails.

• `<NotificationFrom>` — To address to use for notification emails.

• `<NotificationCC>` — CC address to use for notification emails; you can use as many of these tags as you like.

• `<NotificationBCC>` — BCC address to use for notification emails.

• `<NotificationEmail>` — Text of notification email.

• `<CheckForUpdates>` — 1 to check dcpomatic.com for new versions, 0 to check only on request.

• `<CheckForUpdates>` — 1 to check dcpomatic.com for new text versions, 0 to check only on request.

• `<MaximumJ2KBandwidth>` — Maximum J2K bandwidth (in bits per second) that can be specified in the GUI.
• `<AllowAnyDCPFrameRate>` — 1 to allow users to specify any frame rate when creating DCPs, 0 to limit the GUI to standard rates.

• `<AllowAnyContainer>` — 1 to allow users to use any container ratio for their DCP, 0 to limit the GUI to standard containers.

• `<LogTypes>` — Types of logging to write; a bitfield where 1 is general notes, 2 warnings, 4 errors, 8 debug information related to encoding, 16 debug information related to encoding, 32 debug information for timing purposes, 64 debug information related to sending email.

• `<AnalyseEBUR128>` — 1 to do EBUR128 analyses when analysing audio, otherwise 0.

• `<AutomaticAudioAnalysis>` — 1 to run audio analysis automatically when audio content is added to the film, otherwise 0.

• `<Win32Console>` — 1 to open a console when running on Windows, otherwise 0.

• `<Signer>` — Certificate chain and private key to use when signing DCPs and KDMs. Should contain `<Certificate>` tags in order and a `<PrivateKey>` tag all containing PEM-encoded certificates or private keys as appropriate.

• `<Decryption>` — Certificate chain and private key to use when decrypting KDMs.

• `<History>` — Filename of DCP to present in the File menu of the GUI; there can be more than one of these tags.

• `<DKDMGroup>` — A group of DKDMs, each with a `Name` attribute, containing other `<DKDMGroup>` or `<DKDM>` tags.

• `<DKDM>` — A DKDM as XML.

• `<CinemasFile>` — Filename of cinemas list file.

• `<ShowHintsBeforeMakeDCP>` — 1 to show hints in the GUI before making a DCP, otherwise 0.

• `<ConfirmKDMEmail>` — 1 to confirm before sending KDM emails in the GUI, otherwise 0.

• `<KDMFilenameFormat>` — Format for KDM filenames.

• `<KDMContainerNameFormat>` — Format for KDM containers (directories or ZIP files).

• `<DCPMetadataFilenameFormat>` — Format for DCP metadata filenames.

• `<DCPAssetFilenameFormat>` — Format for DCP asset filenames.

• `<JumpToSelected>` — 1 to make the GUI jump to the start of content when it is selected, otherwise 0.

• `<Nagged>` — 1 if a particular nag screen has been shown and should not be shown again, otherwise 0.

• `<PreviewSound>` — 1 to use sound in the GUI preview and player, otherwise 0.

• `<CoverSheet>` — Text of the cover sheet to write when making DCPs.

• `<LastKDMWriteType>` — Last type of KDM-write: flat for a flat file, folder for a folder or zip for a ZIP file.

• `<LastDKDMWriteType>` — Last type of DKDM-write: file for a file, internal to add to DCP-o-matic’s list.

• `<FramesInMemoryMultiplier>` — value to multiply the encoding threads count by to get the maximum number of frames to be held in memory at once.

• `<DecodeReduction>` — power of 2 to reduce DCP images by before decoding in the player.

• `<DefaultNotify>` — 1 to default jobs to notify when complete, otherwise 0.

• `<Notification>` — 1 if a notification type is enabled, otherwise 0.
• `<BarcoUsername>` — Username for logging into Barco’s servers when downloading server certificates.
• `<BarcoPassword>` — Password for logging into Barco’s servers when downloading server certificates.
• `<ChristieUsername>` — Username for logging into Christie’s servers when downloading server certificates.
• `<ChristiePassword>` — Password for logging into Christie’s servers when downloading server certificates.
• `<GCCUsername>` — Username for logging into GDC’s servers when downloading server certificates.
• `<GCCPassword>` — Password for logging into GDC’s servers when downloading server certificates.
• `<InterfaceComplexity>` — `simple` for the reduced interface or `full` for the full interface.
• `<PlayerMode>` — `window` for a single window, `full` for full-screen and `dual` for full screen playback with controls on another monitor.
• `<ImageDisplay>` — Screen number to put image on in dual-screen player mode.
• `<RespectKDMValidityPeriods>` — 1 to refuse to use KDMs that are out of date, 0 to ignore KDM dates.
• `<PlayerLogFile>` — Filename to use for player activity logs (e.g. starting, stopping, playlist loads)
• `<PlayerLogFile>` — Filename to use for player debug logs
• `<PlayerContentDirectory>` — Directory to use for player content in the dual-screen mode.
• `<PlayerPlaylistDirectory>` — Directory to use for player playlists in the dual-screen mode.
• `<PlayerKDMDirectory>` — Directory to use for player KDMs in the dual-screen mode.